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Copyright © 2012 NHN Corp. All Rights Reserved. 
 
This document is provided for information purpose only. NHN Corp. has endeavored to verify the 
completeness and accuracy of information contained in this document, but it does not take the 
responsibility for possible errors or omissions in this document. Therefore, the responsibility for the 
usage of this document or the results of the usage falls entirely upon the user, and NHN Corp. does 
not make any explicit or implicit guarantee regarding this. 
Software products or merchandises mentioned in this document, including relevant URL information, 
conform to the copyright laws of their respective owners. The user is solely responsible for any results 
occurred by not complying with applicable laws. 
 
 

Important Information Regarding Open Source Licenses 

There are several types of open source licenses. XE is licensed under the GNU Lesser General Public 
License (LGPL) v2. As there is a slight difference between LGPL v2 and LGPL v3, it is important to 
keep the version in mind. LGPL is basically the same as GPL, but its scope of application is more 
restrictive. Like GPL, LGPL has the effect of forcing all software that includes any LGPL-licensed 
software to have the same license. While GPL requires all software that includes any GPL-licensed 
software to unconditionally open its source codes, LGPL-licensed programs do not need to open their 
source code when they are used under specific conditions. Therefore, LGPL-licensed software can also 
be used for developing proprietary software. For more information, see the website below. 
LGPL License: http://www.gnu.org/copyleft/lesser.html 
GPL License: http://www.gnu.org/licenses/gpl.html 
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Introduction to Document 
 

Document Overview 

This document describes how to install and use XE which enables you to build websites and 

manage contents. 

Audience 

Audience of this document is users who want to build and operate websites including Cafes and 

blogs by using XE. 

Contact 

For any comments or inquiries regarding the document, contact via email below. 

Email: developers@xpressengine.com 

Revision History 

Ver. Date Changes Mode 

1.0 2010.10.29 1.0 version distributed. 

2.0 2011.12.30 Updated based on XE core 1.5 
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Conventions 

Note Symbol 

Note 
A note provides information that is useful for readers. 

Caution Symbol 

Caution 
A caution provides information that you should know in order to prevent system damages. 

Window, Site, Menu, and Field Names/Selected Value and Symbol 

Window, site, menu and field names, a selected value, and a symbol are marked as follows: 

• Window name: In bold type such as window name window. Note that this convention is not 
applied in source code. 

• Site name: Enclosed in single quotations such as 'Naver Desktop Download’ site. 

• Menu name: In bold type such as Menu > Submenu. 
• Input value: In italic type such as homepage. 

Source Code 

Source code is written in black on a gray background in this document. 

COPYDATASTRUCT st; 
st.dwData = PURPLE_OUTBOUND_ENDING; 
st.cbData = sizeof(pp);  
st.lpData = &pp;  
::SendMes(GetTargetHwnd(), WM_COPYDATA, (WPARAM)this->m_hWnd, (LPARAM)&st); 
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This chapter provides a definition of XE, and describes its features and characteristics. 

1. Introduction to XE 
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1.1 What is XE? 

The name 'XE' is a combination of two words, 'eXpress' and 'Engine.' It can be defined as 'a 
system to help people express their thoughts or feelings.' 

XE is a website creation program that is installed on a server computer. To make a website, 
you generally need to know programming languages such as HTML, CSS, PHP and SQL. But if 
you use XE, you can easily make a website without being familiar with any programming 
languages. 

Based on a core program, XE core, XE enables you to combine various features and make the 
website you want.  

 

Figure 1-1 XE Summary 

Note 
For detailed information on XE, see the official XE website. 
http://www.xpressengine.com 

 

http://www.xpressengine.com/
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1.2 Features and Characteristics of XE 

The features and characteristics of XE are as follows: 

Easy Website Construction 

XE provides diverse modules such as Textyle (blog type), CafeXE (Cafe type) and PlanetXE 
(micro-blog type). You can conveniently construct the website you want to make by selecting 
the appropriate modules.  

Modular Structure 

A module in XE is a program. XE is composed in a modular structure, making it easy to 
construct, add and use features, like building with Lego blocks. You can construct diverse 
websites by combining the basic modules provided by XE with the extended features shared 
through communities. Developers can easily develop additional modules for XE with new 
features, and share them through XE communities. 

Open Community 

XE provides a lot of information through its open community. In the XE community, there are 
many users who have used XE since ZeroBoard, and free and open source project members. 
Users can search the community for the information they want, and ask other users for the 
information at will.  

Multi-language Support 

XE supports multiple languages for multiple countries. You can easily create a website that 
displays in English, Japanese, Chinese, Russian and others languages, as well as Korean, 
without the separation of the website by language. 
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1.3 Terminology 

FileZilla 

A free file transfer protocol (FTP) program. Its official website is http://filezilla-project.org/. 

mod_rewrite 

A function that shortens a long URL to make it easy to remember. For example, 
http://example.com/index.php?module=admin can be shortened to 
http://example.com/admin. This feature can be used only when it is supported by the Web 
server. 

PuTTY 

A remote access program that supports Telnet or Secure Shell (SSH) protocol. The official 
website is http://www.putty.nl. 

WPI 

An abbreviation of Web Platform Installer. Microsoft provides this tool to enable the use of 
Web Platform products, and its official website is http://www.microsoft.com/web/default.aspx. 

XE core 

Core program that is responsible for the installation and operation of XE. XE core is used to 
install and execute extensions, such as module, layout and skin. 

Extensions of XE 

Components that can be added to XE core for user convenience in website operation. They 
include modules, addons, widgets, skins, widget styles and layouts. 

XE 

An abbreviation of XpressEngine. This is the website builder program that is installed on and 
used from a server computer, and its official website is http://www.xpressengine.com/. 

Virtual website 

This function enables you to use a web page made by XE as another website separate from 
XE’s default website. 

Layout 

A component that is responsible for the arrangement of extensions installed on a website. 

  

http://filezilla-project.org/
http://www.putty.nl/
http://www.microsoft.com/web/default.aspx
http://www.xpressengine.com/
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Module 

Program that can be added to XE for use 

Easy Install 

This feature enables you to install a selected extension by interworking with the official 
website for XE without downloading any source program from the official website for XE and 
uploading it to a server. 

Skin 

A design of program installed on any website. 

Addon 

A small program that makes an interrupt between the operations of module features to 
perform their own functions. 

Widget Style 

A component that decorates the appearances of widgets. 

Widgets 

A component inserted into a layout or a page module for operation. 

ZeroBoard 

The most popular bulletin board system that was developed in 1999 in Korea. The software 
has been developed into the current XE through ZeroBoard XE. 

 

 





 

 

  

This chapter describes how to install and uninstall XE. 

2. Installation and Removal 
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2.1 Prerequisite 

XE is a web application for setup. To create a website by using XE, you need a web server on 
which XE is installed. The server space to install XE can be secured in several ways, but the 
following two ways can be considered: using a computer directly as a server, or leasing web 
server space provided by a web hosting provider at some cost.  

2.1.1 Required Programs 

The list of programs required for installing XE in the web server environment is shown in the 
table below. If you use Microsoft Web Platform Installer to install XE, the programs listed in 
the table will be automatically installed. If you do not use one of these installers, you must 
check and set up the required programs and libraries in advance. 

Table 2-1 The List of Required Programs 

Program Mandatory/Optional 

PHP 4.x ~ 5.x (excluding 
5.2.2) 

 Mandatory 

PHP library XML library Mandatory 

GD library Mandatory 

ICONV Optional 

Database Management System 
(DBMS) 

CUBRID Choice 

Firebird 

MySQL 4.1 or higher 

PostgreSQL 

SQLite2 and SQLite3 

MS-SQL 

2.1.2 Downloading XE Core Setup File 

To create a website by using XE, you must set up XE core. XE core is the core program 
responsible for the installation and operation of XE. XE does not have any website 
management related features. However, XE core is essential for the installation and execution 
of extensions such as modules, layouts and skins. 

You can download the latest XE core setup file from the website 
(http://code.google.com/p/xe-core/downloads/list) for free. 

Note 
If you install XE by using WPI on Windows, you do not need to download the XE core setup file. 

The XE core setup file is provided in two types, which are zip and tar.gz. Download the zip file 
if you want to upload the files to the server after extracting them on My Computer, or the 
tar.gz file if you want to extract the compressed file after uploading it to the server. For more 
information in the file upload method used for each type, see "Uploading XE Core Setup File by 
Formats." 

http://code.google.com/p/xe-core/downloads/list
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2.2 Setting Up a Server Environment 

Regardless of the type of server OS, XE can be installed in all environments where "Required 
Programs" is installed. You must build the required Web server environment before installing 
XE.  

You can install XE and the required programs in the Windows environment by using WPI. For 
more information, see the example "Setting Up a Windows Environment." 

Before installing XE in the Linux environment, you must install the programs in "Required 
Programs" manually. The detailed setup procedure for each program is not covered in this 
document. For detailed information on setting accounts, getting access to a server from a 
remote website and uploading the XE core setup file, see "Setting Up a Linux Environment." 
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2.3 Installing XE Core 

This section describes how to install XE core by using the XE core setup file. 

1. With a Web browser, access the path (www.example.com or www.example.com/xe), where 
the XE core setup file is uploaded. If you install it in your local PC using APMSetup, access 
http://127.0.0.1 or http://127.0.0.1/xe. 

2. When the XE Installation window appears, check GNU Lesser General Public 
License(LGPL v2) Agreement, and Agreement on gathering installation 
environment information if you agree with that, and click I agree with the license. 

 

Note 
If this page has a broken image or is empty, you must upload the XE core setup file again. 

3. Check to ensure all required setup conditions are marked as Enable, and click Continue 
installation. 

This window shows whether the minimum PHP version and the required libraries are 
installed. If any of the required setup conditions are not marked as Enable, check the error 
message and mark the item.  

Note 
If Permission is marked as Disable due to a file permission settings error, see "Incomplete 
Permission Settings When Installing XE." 

4. Select the DBMS to be used in XE, and then click Continue installation. In case of this 
document, select mysql. 
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Note 
If there is no DBMS available in XE, all items will be deactivated. In this case, install the DBMS to be 
used, or ask your web hosting provider to install it. 

5. As shown in the figure below, enter the required information for DB, and click Next. 

 

Note 
If a problem occurs while you enter DB information, see "Incorrect DB Account Information." 

6. Check whether to use Rewrite mode, and set the website's local standard time, click 
Next. 

7. Enter the information for administrator. Since XE 1.5 or higher version uses an email 
address as login account, you need to enter the actual administrator's email address. 
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8. When the installation is completed, the 'Welcome XE' page will appear, as shown in the 
figure below: 
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2.4 Removing XE Core 

If XE is no longer being used, delete all contents under the folder where XE is installed. 

All data used for the administration of the website created by XE is stored in the database. If 
you want to delete all data, delete all DB tables used for the administration of your website. 
When you install XE again or transfer your server, you can reuse the data after migration.  

For detailed information on how to delete or migrate data, see the usage of DBMS used for the 
administration of your website.  

 

 





 

 

  

This chapter explores each menu of XE core. 
  

3. Menus of XE Core 
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3.1 Index Admin Page 

As shown in the figure below, open the XE Admin Page, enter the administrator account and 
log into the page. 'example.com' of the address below indicates the domain address where XE 
is installed. 

• When using mod_rewrite: http://example.com/admin 
• When not using mod_rewrite: http://example.com/index.php?module=admin 

 

Figure 3-1 XE Admin Page 
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3.2 XE Administration Menu 

This section describes the default menu available for the administrator. 

3.2.1 Dashboard 

This menu shows the XE Admin home, including current status of the website, latest 
trackbacks, notice and favorites. 

3.2.2 Site 

Site Map 

This menu is used to build complete websites with no manual work by arranging created 
modules and connecting them to layouts through the convenient menu management. The 
menu only has the information to connect modules to layouts and show various types of 
menus through the layouts, and not to manage websites. When you add a menu, you can also 
create a module to connect with, and directly open the admin page of the module. 

3.2.3 Member 

Member List 

This menu shows the list of members who registered in this website. This menu is used to 
create, edit and delete member information; for example, you can change member groups or 
block login of a member.  

Member Setting 

This menu is used to set the information required for member management, including Accept 
New Members and Signup Form. 

Member Group 

This menu is used to manage member groups; you can create, change or delete groups. 

Point 

You can grant points to members when they write, upload or download original posts or 
comments. In addition, you can set the level of groups, and set to upgrade the level based on 
points. 

3.2.4 Contents 

Document 

This menu is used to manage documents registered on websites. You can see and delete 
document contents and check reported/deleted documents. 

Comment 

This menu is used to manage comments registered on websites. You can see and delete 
comments, and check reported comments. 
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Trackback 

This menu is used to view the lists of trackbacks or links from outside the site. You can select 
whether to allow trackbacks or not. If trackbacks are not allowed, they cannot be received and 
will not be displayed even if you link them. 

File 

This menu is used to manage files attached to posts. You can delete the attached files as well. 

Poll 

This menu is used to manage polls registered on websites. 

RSS 

This can provide integrated Rich Site Summary (RSS) feeds composed of various modules 
created through XE. The default value is to use Aggregated Feeds. Integrated feeds are 
provided through the initial website window, and individual modules not allowed to open feeds 
are excluded from the RSS feed list. As in some modules, the default value of open feed is set 
to Do Not Open, you must check whether the Open Text item is set to Open Full Text 
Feed or Open Feed Summary in the Additional Settings of each module. 

Multilingual 

XE supports multilingual website; you do not have to create separate global websites. You can 
add words and sentences to Multilingual, and they are automatically applied to the website UIs 
and displayed when you change the language. 

This menu manages the list of multilingual words and sentences; you can check the list and 
add new words or sentences. 

Data Migration 

This menu is used to import data from ZeroBoard 4, zb55beta or other program. 

Trash 

When you delete documents or comments, they are moved to Trash, not actually deleted from 
DB. The administrator can restore them or completely delete them. 

3.2.5 Theme 

Theme 

Theme is a set of skins and layouts for modules currently installed. This menu shows all 
themes and modules installed in the website. When you select a theme, the module skin is 
changed to the selected theme (No Selected XXX Skin means that the selected theme does 
not support the module). When you save the theme setting, it is applied to the skin and layout 
information in all the module instances created in the website. 

3.2.6 Extensions 

Easy Install 

This menu enables you to set up the extensions including modules, skins, layouts, and widgets 
on your website by connecting with the official website for XE. You do not need to download 
the source from the official website and upload it to your server. 
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Installed Layout 

This menu is used to manage the layouts installed on the website. You can add, edit or delete 
instances.  

Installed Module 

This menu shows the installed modules. You can manage modules on the management page 
for each module. You can also set frequently used modules as Favorite so that you can 
conveniently use those modules by using Favorite menu on upper right side of the page. 

Installed Widget 

This menu shows the installed widgets. You can create code for each widget. 

Installed Addon 

This menu shows the installed addons. You can set whether to use each addon on PC and 
mobile device. 

Note 
Using XE core 1.5 or higher version, you can delete layouts, modules, widgets and addons installed 
by using Easy Install on the management page of Extensions > Installed Layout, Installed 
Module, Installed Widget and Installed Addon. 

WYSIWYG Editor 

This menu enables you to set the basic WYSIWYG editor and manage the editor component. 

Spam Filter 

This menu is used to identify spam posts or comments and block them. You can set IP 
addresses and keywords to ban. 

3.2.7 Settings 

General 

This menu is used to set basic matters such as the default module for the site and the default 
language. It also enables you to set advanced matters such as IP address band that can 
access the Admin Page. 

FTP Configuration 

This menu is used to set user ID and password for FTP connection in order to use Easy Install. 

Admin Setup 

This menu is used to set title, logo and menus for the Admin Page. 

File Upload 

This menu is used to set the allowed formats and size of files to upload. 

FileBox 

This menu is used to manage FileBox, which contains images that can be reused by 
administrators. When you upload an icon for a member group, the image file is uploaded to 
the FileBox. 





 

 

  

This chapter describes types of extensions in XE, and how to install them. 
  

4. XE Extensions 
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4.1 Types of XE Extensions 

The biggest advantage of XE is that XE enables you to operate websites more conveniently by 
adding diverse features. This section describes the extensions of XE. For information on how 
to install each extension, see "How to Install Extensions." 

Module 

A module in XE is a program. Multiple modules can be combined into a bigger module, and 
each module can operate independently. In short, modules are programs that are additionally 
installed to implement specific features on websites. 

Bulletin board, CafeXE and Textyle can be considered the representative modules provided in 
XE.  

 

Figure 4-1 Modules 

Addon 

A small program that interrupts between the operations of modules and performs its own 
operations. In addition to modules, addons execute their own features by themselves. 
However, addons are different from modules in that they do not provide the execution results 
to outside.  

Default counter and mobile XE are examples of the representative Addons provided by XE.  
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Widget 

A widget is inserted into and operated in a layout or a page module. Widgets can display data 
already created in modules, or create its own data. For example, you can use a widget to 
display the list of the latest posts in the front page of your website. Language selection and 
login information display widgets are examples of representative widgets provided by XE.  

Widget Style 

A widget style is used to decorate a widget. If a skin decorates the output part of a widget, 
the widget style can be considered a skin for the appearance of a widget. By applying widget 
styles, you can add contents, such as titles and other links, to widget blocks as well as change 
their appearance. 

 

Figure 4-2 Widget and Widget Style 

Skin 

A skin is the design of programs installed in websites. In other words, a skin can be 
considered as the clothing of a program (modules or widgets). 

The XE official website provides various skins for each program. Appropriate use of these skins 
will make you operate a better website that reflects your unique personality. 
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Layout 

After installing various extensions on your website, you must arrange them on the screen 
appropriately. The layout is responsible for this screen arrangement. A layout has a very close 
relationship with extensions such as modules and widgets. As the layout cannot display any 
content without those extensions, nothing is displayed in the screen. If, in the other hand, a 
program is installed but there is no layout, the screen will also remain blank or empty because 
each element will not know where it is to be displayed. 

 

Figure 4-3 Layout 
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4.2 How to Install Extensions 

Various extensions can be installed in XE in two ways: Uploading source files to the server 
where XE is installed after downloading the files from the official XE website, and using Easy 
Install provided by XE core. 

Note 
Installing extensions in XE means transferring the source codes of the extensions into the operating 
server. In short, the contents to be displayed in the actual website cannot be created through the 
installation of the extensions alone. For more information on how to create extensions and make 
them interwork with websites, see "Creating Websites."  

4.2.1 Installing Extensions by Uploading Source Files 

You can download source files for extensions from the XE official website, and upload them to 
the server where XE is installed. 

Note 
Please understand that this document was originally prepared for the users who use XE's Korean 
official website. We will soon release a new document for worldwide users of global website. 

For example, to install a bulletin board module by uploading source files, do the following. 

1. Access the archive of the XE official website (http://www.xpressengine.com/download). 
2. Select one of the bulletin board modules and download it to My Computer.  

 

http://www.xpressengine.com/download
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3. Extract the bulletin board module from the zip file you have downloaded. When the 
extraction is complete, a directory called 'board' is created.  

4. Move the extracted 'board' directory to the './modules' directory under the XE installation 
path. All modules are installed in the '/modules' directory under the XE installation path. 

5. Select Extensions > Installed Module and check if the board module is added as shown 
in the figure below.  

 

6. Click Would you like to update? to complete the installation. 
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4.2.2 Installing Extensions by Using Easy Install 

Setting FTP 

To install extensions by using Easy Install, you must set the account to use Easy Install. The 
procedure used to set an account is as follows: 

1. Click Settings > FTP Configuration on the XE Admin Page.  
2. Enter the information for FTP connection as shown below:  

− FTP hostname: The host address which the server where XE is installed will access. 
Unless otherwise specified, XE components are usually installed in the server where XE 
is installed. Therefore, enter localhost or 127.0.0.1.  

− User ID: A user ID for the server 

− Password: A password for the user ID 

− FTP port: By default, the FTP port number is set to 21, but it may vary depending on 
the server. If the port number is not 21, contact your server administrator. 

− Use FTP Passive Mode?: This feature enables you to use FTP service normally even 
when clients (web server to be used) are behind a firewall. To get FTP connections to 
work through a firewall, select Yes. Therefore, to use Easy Install, the server must 
support the FTP Passive mode.  

− Use SFTP?: The data transferred via FTP is not encrypted. Using SSH File Transfer 
Protocol (SFTP) enables you to use Easy Install more safely. You can use SFTP only 
when the related PHP module is installed. 

− Absolute FTP path of XE: FTP path indicates the absolute path to the location where 
the XE source code exists. Enter the absolute FTP path. For example, if the account for 
XE installation and FTP setting are 'xemanual' and the path to XE source is 
'/home/xemanual/xe', you must enter the absolute FTP path of the xemanual user, 
which is /xe/.  

Note 
To enter a home directory, you must add '/' to the end of the directory path. 
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3. Click Get List, and if you can get list with no error, click Save. 

Now, the account setting to use Easy Install is completed.  

Note 
If any error related to FTP home directory occurs during the execution of Easy Install, see "FTP Home 
Directory Inaccessible during Easy Install." 

Using Easy Install 

For example, the procedure used to install the Textyle module through Easy Install is as 
follows: 

1. Click Extensions > Easy Install on the XE Admin Page.  
2. Find the Textyle module and click Install at the right side of the module description. When 

the module is installed completely, Install button disappears. 
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This chapter describes how to create websites by installing various extensions. While XE enables you 
to create various types of websites, this chapter only describes how to create basic websites and Cafe 
and blog type websites.  

 

5. Creating Websites 
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5.1 Creating a Basic Website 

This section covers how to create a simple and basic website to display three boards, menus 
linked with each board and the latest posts on the main page.  

The complete website that will be created in this section is shown in the figure below. 

 

Figure 5-1 Basic Website 

5.1.1 Installing Extensions 

Installing a Layout 

Install a layout module before creating a website.  

1. Move to Easy Install window by clicking Easy Install at the top left of the XE Admin Page.  
2. From the layout skins, search for 'XE official Ver2,' and click Install at the right side.  

Note 
You can also install extensions by uploading source files with no use of Easy Install. For more 
information, see the example "Installing Extensions by Uploading Source Files." 

Installing a Board Module 

Install the board module. For more information on installing modules, see "How to Install 
Extensions." 
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5.1.2 Managing Site Map 

You can create and manage modules of your website using Site Map menu. Let's create Home, 
Notice, Freeboard and LevelUp board menus, and connect them with each board or page. 

1. Click Site > Site Map from the menu in the XE Admin Page. 
2. You can use welcome_menu, which is automatically created when you install XE. First of 

all, delete menu1-1 and menu1. 

 

3. Click Add Menu. 
4. When Add Menu window appears, enter Home for Menu Name, select Create Module for 

Module or URL and Page > Widget Page for Select Module. Enter home for Create 
Module ID and click Save. Then, you can see that the Home menu is added under the 
welcome_menu. 

− Menu Name: A name for menu. The name may contain all letters and numerals 
without limitation. 

− Module or URL: Contents to be connected with the new menu. 

− Create Module: Create a new module. 

− Select Module: Select one from the existing modules in my website. 

− Menu URL: Connect to the external link (including 'http://') 

− Create Module ID: A name used to access the relevant module. The name may 
contain letters and numerals, but it must start with a letter. In addition, the name must 
not duplicate the name of another board or page. Since the module name is the name 
of the page to be displayed in the address bar of a web browser, you must use 
alphabets and numbers only. 

You can see that the window is converted into the Boards List tab and Freeboard has 
been added to the list. 

5. Create the remaining three menus, notice board, freeboard and levelup board in the same 
order as the above procedure.  

− notice board: Set Menu Name to notice board, select Create Module and Board for 
Module or URL, and set Create Module ID to notice01, respectively. 

− freeboard: Set Menu Name to freeboard, select Create Module and Board for 
Module or URL, and set Create Module ID to freeboard01, respectively. 

− levelup board: Set Menu Name to levelup board, select Create Module and Board for 
Module or URL, and set Create Module ID to levelup01, respectively. 
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You can see that the four menus have been created in the Site Map page as shown in the 
figure below. 

 

5.1.3 Creating a Layout 

After creating modules and menus, you need a layout to display them in the screen. Create 
layouts in "Installing a Layout", and integrate them with menus.  

When creating XE layouts, you provide diverse screen effects by changing various settings. 
The procedure used to create layouts is as follows: 

1. Select Extensions > Installed Layout in the XE Admin Page. 
2. Click XpressEngine ver.2 layout previously installed (see 5.1.1). 
3. Click Insert at the bottom right of the list.  
4. Set the following items in the page of inserting layout, check Apply Layouts En Bloc and 

click Insert at the bottom right of the window. 

− Subject: main_layout 

− Menu: welcome_menu 
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5. Check whether the 'main_layout' has been added to the layout list as shown in the figure 
below. 



5. Creating Websites 

 

 
44  

 

 

Since the layout has been created, set this layout to the three boards previously created. Now, 
you can check the contents of each board through your web browser. 

5.1.4 Modifying a Page 

This section describes how to modify a page to view the latest posts in each board.  

1. Select Extensions > Installed Module from the XE Admin Page. 
2. Click Page module. 
3. Click the browser title of the page to modify.  
4. When the created page is displayed, click Modify at the right side of the window. 
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Note 
If you access the page with the administrator authority, Re-create cache file, Configure, Modify 
buttons are displayed to edit or set the contents of the page. If you cannot see these buttons, check 
whether you are logged in as an administrator. 

To display the latest posts on a page, you will need a widget to display contents. At first, let’s 
create widget to display the contents of the Freeboard. 

5. If the Modify window appears as shown in the figure below, select Content and click 
Insert. 

 

6. When the Generate Code window appears, enter the required items and click Generate 
Code. 

− Theme: Content widget default skin (default) 

− Cache: 5 min 

− Target: Article 

− Target Module: Select a module to display for widget. 

− Content Type: Image + Title + Content 

− Tab Type: None 

− HTML Display Type: Table 

− Display Target and Order: title, regdate, nickname, content 

− Display Article Name: No Display 

− Comment Count: Display 

− Trackback: Display 

− Category: Display 

− Icon: Display 

− Target to be sorted: Newest Submitted Order 

− Sorting Type: Descending order 

− Thumbnail Type: Crop 
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− Width of Image: 100 

− Height of Image: 75 

− Number of Images: 5 

− Number of Lists: 5 

− Page: 1 

− Duration of indication for new item: 12 

− Length of Subject: 0 

− Length of Content: 100 

If the widget has been created, you can see the window as shown in the figure below. 

 

Note 
If there is no post on the boards, no contents appears in the widget. To check the contents of the 
widget, you must write posts on each board for test in advance. 

Let’s apply a widget style in the upper part of the widget to insert names and links that enable 
you to move to the boards.  

7. Move your mouse cursor over the added widget area, and click the Add Widget Style icon 
( ) from the icon menus displayed at the top left of the widget area.  

8. If the Widget Style popup window appears, select Simple Strong as the widget style to be 
applied and click Configure. 

9. If the Configure Widget Style window appears, set as follows:  

− Colorset: White 

− Title: Freeboard 

− more URL: Enter the URL of the corresponding board. Since the module name of the 
Freeboard is freeboard01, enter http://xeInstallation Path/freeboard01  
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− more text: It indicates the text to move to the board integrated with widget. In case of 
this example, specify as more. 

10. Check if the widget style is applied to the widget of the Freeboard as shown in the figure 
below. 

 

11. Create widgets to be connected with the remaining two boards and apply widget styles. 

Since all contents to be entered when creating code for Notice are the same as those 
entered when creating Freeboard widgets only excluding the setting information below, 
create the code for Notice referring to the widget creation process for Freeboard. 

− Content Type: Image + Title + Content 

− Display Target and Order: title, regdate, nickname 

− Target Module: Click Insert and select Notice for Module in the Module Selector 
popup window. 

All contents to be entered when creating LevelUp Board code are, also, the same as those 
entered when creating Freeboard widget only excluding the setting information below. 

− Content Type: Image + Title + Content 

− Display Target and Order: title, regdate, nickname 

− Target Module: Click Insert and select LevelUp Board for Module in the Module 
Selector popup window. 

 

12. Check if three widgets are added as shown in the figure below. However, the widget 
contents may vary depending on the posts. 
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If the widgets are completely created, arrange them again. In this example, leave the 
widget for Freeboard and arrange the widgets for Notice and LevelUp Board side by side 
under the widget for Freeboard. 

13. Move your mouse cursor over the added widget area, and click Arrow icon ( ) from the 
icon menus displayed at the top left of the widget area. 

14. If the Set Widget window appears as shown in the figure below, change the attribute of 
Align Widget into Right to make enough space to place the Notice widget in the left side 
of the LevelUp Board and click Save.  
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15. Drag the Resize Handle icon ( ) in the lower left of the LevelUp Board and move to the 
right direction until the horizontal size of the widget is reduced by about 1/2. 
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16. Drag the Resize Handle icon ( ) in the lower right of the Notice widget to the left direction 
to reduce its size. If the horizontal width of the Notice widget becomes smaller than the 
empty space of the left side of the LevelUp Board, they are arranged side by side. 

17. If the arrangement is completed as shown in the figure below, click Save from the menu at 
the bottom right. 
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5.2 Creating a Cafe Type Website 

CafeXE module is used to distribute cafes to members in a website. It enables you to manage 
administrator and members for each Cafe and operate the cafes by integrating different types 
of XE modules. If you want to distribute and manage cafes, build your website referring to the 
description below. 

Note 
Since you can create virtual websites and distribute Cafe type and blog type websites (see the next 
section) to desired users, you can build specialized websites.  
The virtual website is the feature to use web pages created in XE as separate websites different from 
the default websites of XE. This feature will give an opportunity to operate virtual websites with 
settings different from XE default websites.  
You can manage the virtual website through separate management pages for each virtual website. In 
addition, you can hand over the authority for virtual website management page to another user to 
distribute the virtual website. CafeXE and Textyle create and manage individual Cafes and blogs with 
this virtual website functionality. 

The completed Cafe type website to be created in this section is shown in the figure below. 
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Figure 5-2 Cafe-Type Website Main Page 
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Figure 5-3 Individual Cafe 

5.2.1 Installing Extensions 

In this section, you need the following modules, layouts and skins for the construction of a 
Cafe type website. For more information, see "How to Install Extensions." 

Installing Modules 

To build a Cafe type website the following modules are required:  

• CafeXE module 
• Board module 
• Navigator widget 
• Image counter widget (image_counter) 
• Site information ver. 0.1 

Installing Layouts 

The following layout and skin are used for the creation of the Cafe type website:  

• CafeXE Layout ver.0.1 
• Login_info Widget Default Skin ver.0.1 

Note 
If installing CafeXE through Easy Install, you can use CafeXE more easily because the required 
programs are automatically installed. 
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5.2.2 Creating Café Hub Layouts 

Creating a Café Hub Layout 

1. Click Extensions > Installed Layout in the XE Admin Page.  
2. Click XE Café Official Layout. 
3. Click Insert at the bottom right of the layout list. 
4. Enter Cafe Hub Layout to the Subject field and click Insert. A new layout is created. 

Checking CafeXE Management Menus 

Select Extensions > Installed Module and click CafeXE, and the CafeXE Management 
page appears.  

Note 

Click Favorite ( ) next to a module on the installed module list, and the module is displayed on the 

Favorite ( ) at the top right of the page. 

 

Figure 5-4 CafeXE Management Page 

The CafeXE Management page is composed of four tabs as follows: 

• Cafe List: You can see the list of the created individual cafes. 
• Create Cafe: You can create new cafes. 
• Configure cafe: You can configure the access IDs for Cafe’s main screen and manage the 

settings required for individual Cafe website. 
• Cafe Hub Skin: You can build the main page screen of CafeXE. This menu is used to enter 

the title and description of the main page and introduce specific cafes.  

5.2.3 Creating a Café 

You can create a cafe as follows: 

1. Click Create Cafe on the CafeXE Management page. 
2. Set the followings and click Create a cafe. 

− Title of cafe: Name of a Cafe to be created. Enter CafeXE Introduction Cafe. 
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− Access Type: ID to access the corresponding Cafe. Since this example does not use a 
separate domain, select With Site ID and enter cafe01. 

Note 
You can access a website in two ways:  
- With Domain Name enables you to create and connect with a sub-domain of the domain where 

XE is installed and use additional domain address in use (example: http://domain.example.com). 
- With Site ID enables you to create a mid (module ID) like a separate module that is installed in 

XE and link it to a sub-page of the current website (example: http://www.example.com/ID). At 
this time, the mid must not be the same as that of other modules installed in XE. 

3. Once a cafe is created, you can set the following items on the CafeXE Managegement 
page.  

− CafeXE administrator: Specify an administrator of the created cafe. 

− Default layout: Change the cafe layout. 

− Allow change layout: Check this option to allow the cafe administrator to change the 
cafe layout. 

− Allowed services: Set the types and the numbers of modules for each cafe.  

To use the default settings, click Go Back at the bottom right of the page. 

5.2.4 Configuring a Cafe 

The procedure used to set a cafe is as follows: 

1. Click Configure cafe on the CafeXE Management page.  
2. Enter the following information and click Save at the bottom right of the window. 

− Cafe ID: ID required for connecting the main page. For this example, set the ID of the 
corresponding module to cafe. 

− Browser Title: Text to be displayed on your browser when accessing the main page. 

− Cafe's main layout: Layout to be used for the main page. The list of all created 
layouts is displayed. Find and select Cafe Main Layout previously created. 

− Theme: Skin to be displayed in the text area of the Cafe hub page. For more 
information, please see "Configuring a Cafe Hub Skin." 

− Type of Cafe: Select the method to use to access the Cafe main page. For the 
descriptions about website ID access and Domain ID access, see the Note section in 
"Creating a Café." 

− Cafe creation privilege: Authority level for website members to create cafes 

− Default layout: A layout to be integrated when the individual cafe is created. Select 
the previously created XE Cafe Official Layout. 

− Allow change layout: When this option is checked, an individual cafe manager can 
separately modify his or her own cafe layout. 

− Allowed services: You can limit the default service to be used in an individual cafe. If 
no value is entered in the relevant field, contents can be created without limit. 
Therefore, it is recommended to specify a value only after sufficient consideration. For 
this example, enter 10 for Board and 2 for Page, separately. 

− Config top menu: Menus to be displayed on the top side of the cafe. For how to 
create and manage menus, see "Managing Site Map." 
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5.2.5 Configuring a Cafe Hub Skin 

The procedure used to set a cafe hub skin is as follows: 

1. Click Cafe Hub Skin on the CafeXE Management page. 
2. Check the contents for each area in the figure below and enter the contents to be used for 

the Cafe Hub page. 
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5.2.6 Managing Individual Cafes 

The users with individual cafe management authority can see Configure cafe at the top right 
of individual cafe window. Click this button to move to the management window of each Cafe.  
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Figure 5-5 Individual Cafe administrator Window 

Individual Cafe administrators can set the following items: 

• Configuration: Cafe administrators can modify and register Cafe names, descriptions and 
banner images. 

• Manage groups: Cafe administrators can create member groups and set default groups for 
new members. 

• Member list: Cafe administrators can check the current members, change member groups 
and have members secede from their cafes by deleting the members. 

• Manage menu: Cafe administrators can add or remove boards to be used in their Cafe or 
services such as pages. 

• Utilities: Cafe administrators can activate editor components and addons or change 
settings. 

• Visit Statistics: Cafe administrators can view the statistics about their cafe visitors. 
• Module configuration: Cafe administrators can change detailed settings about each board 

and page included in their cafes. In addition, they can exchange cafe boards and pages 
with different cafes or default websites. 
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5.3 Creating a Blog Type Website 

You can easily build blog type websites by using the Textyle module. The Textyle module 
performs dedicated blog features in XE. It provides very powerful contents production and 
publication features, such as Textyle editor and writing material box.  

Like CafeXE, Textyle provides the virtual website functionality, so you can create and 
distribute new Textyles and operate blog communities. 

The blog type website to be created in this section is shown in the figure below. 

 

Figure 5-6 The Blog Type Website using Textyle 

5.3.1 Installing Extensions 

In this section, you need the following modules, layouts and skins for the construction of a 
blog type website. Install the following items by referring to "How to Install Extensions." 

Installing Modules 

• Textyle module 
• Writing Material Module 

Installing Widgets 

• Tag list 
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• Category mark 

Installing Skins 

• Textyle editor 

5.3.2 Textyle Management Page 

After installing the required extensions, click Extensions > Installed Module and check if 
the Textyle module is displayed. Click Textyle to display the Textyle Management page as 
shown in the figure below.  

 

Figure 5-7 Textyle Management Page 

The Textyle management menu is composed of six sub-menus. 

• Textyle List: You can see the created Textyle list. 
• New Textyle: You can create Textyle by entering access method and administrator ID.  

Note 
You can access the Textyle module in two ways: If you have a domain address in use after installing 
XE, you can connect the website with the domain or create new URL by adding an ID to the website 
address. It is recommended to use the second method when adding Textyle to your website in use. 

• Textyle Menu Customize: You can hide default menus or develop pages or features other 
than default property to add in menus. The menus hidden or added by using this menu are 
applied to all the distributed Textyles in a batch. 

• Blog API Service: Blog API handles the remote publication of posts from any other 
application, and not the administrator’s blog. You can post Textyle posts to any blog 
supporting Blog API in remote locations. 

• Backup Request: You can check the backup request history requested from the distributed 
Textyle. The administrator of the distributed Textyle can perform the Textyle backup in 
Textyle administration mode and the website administrator can back up all the distributed 
Textyles directly. 

• Additional Menu: You can see the list of other modules that can be added to Textyle. This 
menu can limit the number of modules available for each individual. If this value is empty, 
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each individual to whom Textyle is distributed can use the corresponding module without 
any restriction. 

5.3.3 Creating a Textyle 

The procedure used to create Textyle is as follows: 

1. Press the New Textyle tab in the Textyle Management page. 
2. Set Access Type and Textyle administrator (ID) and click New Textyle at the bottom 

right of the window. The settings for this example are as follows: 

− Access Type: With Site ID 

− Textyle administrator (ID): admin 

 

If Textyle is created, the information in the created Textyle appears in the Textyle List tab. 

5.3.4 Configuring a Textyle 

Open the Textyle main page by clicking the created Textyle, and click Admin at the top of the 
Textyle main page. After logging in to the individual administration screen, you can see the 
following window. 
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Figure 5-8 Individual Textyle Administration Window 

Among Textyle administration menus, the sub-menus related to Configuration are as follows: 

• My Profile: It is used to set user information. It enables you to write or modify nicknames, 
E-mail addresses, profile photos and cover letters. 

• Blog Configuration: It is used to set blog information. It enables you to enter or edit blog 
title and one-line introduction, set favicon (Favorites icon attached to the front of website 
address) or set language or time zone for menu. 

• Writing Env.: It is used to set the posting environment. It enables you to, also, set the use 
of Textyle editor, font, posting header or footnote and remote publication feature to draw 
up writings to this Textyle in a remote place. 

• Publish·Comm.: It enables you to specify targets to be exposed to Textyle’s first page and 
the number of the targets, and set whether to send postings to me2day or twitter accounts. 
In addition, it enables you to set types to be sent out from RSS or entry forms for writing 
contents or a guestbook. 

• Remote Blogging: It enables you to set the feature to send out postings written in this 
Textyle to other blogs or boards. 

• Addons: It enables you to set the features of addons installed in this Textyle. 
• Data: It enables you to back up or resume blog posts or data, or initialize your blog. 
• Change Password: It enables you to change Textyle administrator’s password. 
• Additional Menu: It enables you to add modules installed in XE as Textyle menus. 
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5.3.5 Setting Textyle Design 

You can create a better blog with your unique personality by changing Textyle’s skin. It 
enables you to apply default skins provided when installing Textyle or the skins downloaded 
from official website. In addition, after the administrator edits the applied skin, you can modify 
it for your blog. You can also apply blog skins for your mobile unit.  

Installing and Applying Skins 

To apply a new skin, you must install the Textyle skin first. You can download various skins 
from the official XE website (http://www.xpressengine.com/download). 

The procedure used to apply Textyle skins is as follows: 

1. Click Design > Skins from the Textyle administration menu, and then select a skin from 
the default skins to apply to your website. For this example, let’s suppose that you select 
PXE Xesta v2.5 skin. 

Note 
Click a desired skin to check the detailed information on the skin. Since the detailed skin information 
window provides Textyle screen images applying the skin or the URL address of the Textyle website 
that the skin is actually applied to, you can confirm the appearance before you apply the skin. 
Among detailed information items, the installation path indicates the position where you must upload 
source file during the installation process. If you want to upload source code directly to install skins 
with no use of Easy Install, you must keep in mind the installation path. 

2. Click Download in the detailed information window to download the skin file, and then 
upload the file to the skin installation path of the server. For detailed installation method, 
see "Installing Extensions by Uploading Source Files." 

3. Select Design > Skins, and the information in the installed skin appears as shown in the 
figure below. 

http://www.xpressengine.com/download
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Creating Widgets 

Now, we will create three widgets for the applied skin. Let’s specify the settings to display the 
latest posting, reply and trackback list in each widget. 

1. Select Construction > Widget in the XE Admin Page, and the information in the widgets 
installed in your website appears.  

2. Select Content from the default widgets and click Insert. 
3. After setting each field below, click Generate Code. Since the three widgets has the same 

attributes excluding the values of Target, create codes three times after only setting 
Target differently. 

− Widget: Content Widget ver x.x 

− Theme: Content widget default skin (default), Colorset: For white background 

Note 
To specify colorset, select a desired skin from Theme and click Select. To create the code correctly, 
you must specify a colorset after selecting a skin. 

− Cache: 0 min. 

− Target: 

− Latest Post Widget: Post 

− Latest Comment Widget: Comment 

− Latest Trackback Widget: Trackback 

− Content Type: Title 
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− Tab Type: None 

− Display Target and Order: title 

− Display Article Name: No Display 

− Comment Count: Display 

− Trackback: No Display 

− Category: No Display 

− Icon: No Display 

− Target to be sorted: Newest Submitted Order 

− Sorting Type: Descending order 

− Thumbnail Type: Crop 

− Width of Image: (Do not enter) 

− Height of Image: (Do not enter) 

− Number of Images: (Do not enter) 

− Number of Lists: 10 

− Page: 1 

− Duration of indication for new item: Empty 

− Length of Subject: 30 

− Length of Content: (Do not enter) 

− Target Module: (Do not insert) 

− Feed related items: (Do not enter) 

− HTML Display Type: UL 
4. After copying the created codes, close the popup window. 

5. Select the Design > Edit HTML·CSS in the left side of individual Textyle administration 
window. 

6. Select the _el.html tab, and paste the latest post, the latest comment and the latest 
trackback widgets to Recent Entries, Public Voice and Trackbacks tags, respectively. 
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Note 
Even though you have made a skin you like by modifying the skin and inserting a widget skin by 
editing HTML and CSS, the changes will be deleted if you apply another skin. To prevent such case, 
you must back up the skin. The Backup skin, Restore skin, Reset buttons are located at the 
bottom of the Edit HTML·CSS window.  
Backup skin: It enables you to back up the current skin and download the skin again when you want 
after changing the skin.  
Restore skin: It enables you to upload the backup skin again by using the Skin Backup feature and 
apply its modified skin again.  
Reset: It deletes all changes and restores the skin contents into the original status before the skin 
was applied initially. This feature is used to restore any skin into the original status when you cannot 
modify the skin. 
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5.4 Setting a Default Module 

After building your website, you can set the first page (default module) that other users see 
initially when they access your website. When you do not change the default module, the 
Welcome page that is automatically created when you install XE appears. 

1. Select Settings > General on the XE Admin page. 
2. Click Find under You can specify the default module for the site. on Primary section. 

Enter a virtual site ID including a default module, or keep it blank if the default module is 
contained in the main site, and click Confirm.  

3. When the layered pop up list of created sites appears, select one (if there is no virtual site, 
currently used domain information is displayed). 

4. When the module types of the selected site appear, select one for the first page. 
5. When the module instance of the selected module type appears, click Select next to the 

module to select as the first page.  
6. Click Save at the bottom of the page. 



 

 

  

This chapter provides the helpful information to install and use XE. 

6. Appendix 
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6.1 Setting Up a Windows Environment 

You can use WPI to install XE under Windows environment. 

Note 
If you install XE by using WPI in Windows XP, you cannot use mod_rewrite to reduce the length of 
URL to make it easy to remember.  
XE packed in WPI is version 1.4.0.5. If you want to install the latest version of XP, you must 
separately update into XE core after installing with WPI. 

6.1.1 Getting an Account 

To install XE into a Windows server, you must have an account to access to the server. For the 
server account, ask your server administrator. If you administrate the server directly, use the 
existing account or create a new account. 

After specifying the account name, you can select the account type. It is recommended to 
minimize the authority of the account by selecting a limited account to keep the server secure 
as possible.  

6.1.2 Using Remote Desktop Connection 

If you cannot manipulate the server directly, you must access and manipulate the server 
remotely. Windows systems provide the 'Remote Desktop Connection' program to access and 
manipulate another computer. 

To use the Remote Desktop Connection program, you need the server’s domain address or IP 
address. If a domain has been already set, you may access by using the domain. If not, you 
must use IP address. The procedure to check the server IP address and access to it by using 
the Remote Desktop Connection program is as follows: 

1. Execute the command prompt of your Windows server.  
2. Enter the ipconfig command and check the server IP address.  
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3. Execute Start > Accessories > Remote Desktop Connection from My Computer or 
mstsc in the command prompt.  

4. If the Remote Desktop Connection window appears, enter the server IP address to 
Computer and click Connect.  

 

5. If a window to enter server account and password appears, enter the account created in 
"Getting an Account" and log in to the server. 

6.1.3 Using WPI 

WPI is the tool that Microsoft provides for the convenient use of Web platform products. WPI 
automatically install and set required components or Web applications. 

It installs the components necessary for a Web application when you install the Web 
application. If, therefore, you use WPI, the programs necessary for the XE installation are 
installed together when you install XE.  

Download WPI installer from the official website for Microsoft Web Platform 
(http://www.microsoft.com/web/default.aspx).  

Executing WPI Installer and Starting XE Installation 

1. Execute WPI installer and then select CMS in the Web Applications tab.  
2. Click Option at the bottom left of the installer window. 
3. Select Korean for your preferred language and click OK. 

 

http://www.microsoft.com/web/default.aspx
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4. Find and select XpressEngine from the application list in the CMS and then click Install.  

 

5. To install XE core, check additional components to be installed and set and then click I 
Accept. XE core starts to be installed. 

Installing Additional Components 

If additional installation components include MySQL DBMS, you must specify a password 
during installing MySQL DBMS. If a screen to specify administrator password appears, specify 
password and click Continue. 

Note 
If you specify MySQL administrator password for the first time in WPI, the password must contain 
both lowercase and uppercase letters, as well as at least one numeral and one symbol. Since the 
MySQL administrator password is required when installing XE, you must memorize the password.  

If the account is completely set, components start to be installed.  

Entering the Information Required for XE Installation 

After the required components for XE are installed, XE starts to be installed.  

1. As shown in the figure below, enter the information of the website where XE is installed 
and click Continue.  

Unless you want to set some site information in particular, use the default setting as is. 
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2. Enter the following information in the XE core installation and click Continue. 
• Database: A DBMS to be used in XE. Herein, select MySQL. 
• Create a new or use an existing database: Select whether to use the existing database or 

new database for the operation of XE. It is recommended to create new database if 
possible. 

• Database Administrator: A selected administrator ID for the DBMS: Herein, the 
administrator ID of the MySQL is 'root.' 

• Database Administrator Password: A DBMS Administrator’s password for the selected 
DBMS. Enter the MySQL administrator password specified in "Installing Additional 
Components." 

• Database User Name: A user name to access database from XE 
• Database Password: A user password to access database from XE 
• Database Server: The location where DBMS is installed is specified in URL format. In this 

document, since the server and the DBMS are operated in the same computer, enter 
localhost. 

• Database Name: Your existing or new database name to be used in XE 
• Database Table Prefix: A header to be used in table names created in XE 
• Set XE Admin ID: An ID of XE administrator 
• Set XE Admin Name: A name of XE administrator 
• Set XE Admin Nickname: An alias of XE administrator account 
• Set XE Admin Password: A password of XE administrator account 
• Set XE Admin Email address: An E-mail address of XE administrator E-mail account 
• Use URL Rewrite: Whether to use mod_rewrite. If this item is activated, you can reduce 

the URL length to make it easy to remember. 
• GMT Timezone: A local standard time for XE service 

Welcome to XE 

If you complete all installation processes, access your website by using your web browser. If 
the installation is completed successfully, the following window appears.  



6. Appendix 

 

 

 
74  

 

 

Figure 6-1 Welcome to XE! Window 

Note 
When you install XE by using WPI, you need to update XE core to its latest version. Download the 
latest version of XE core from the official XE website, unzip it and then overwrite the contents under 
the XE site installation directory (C:\Inetpub\wwwroot\xe) with the unzipped files. 
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6.2 Setting Up a Linux Environment 

This section describes basic information necessary for the installation of XE by using a Linux 
server. 

6.2.1 Getting an Account 

To install XE, you need the accounts to access the server and the database storing XE 
information. Check server and database accounts as follows: 

1. After logging into the server with the administrator account, create a user account by using 
the useradd command. For more information on the useradd command, see "Command to 
Create Accounts - useradd."  

If, however, your server is provided from a Web hosting provider, ask the provider to set 
up the account. 

2. Check the account information of the database to store all data necessary for XE 
installation and operation. For information on how to create and check the DBMS account 
in use, see the official website.  

− CUBRID official website (http://www.cubrid.com/zbxe/home)  

− Firebird official website (http://www.firebirdsql.org/)  

− MySQL official website (http://www.MySQL.com/)  

− PostgreSQL official website (http://www.postgresql.org/)  

− SQLite official website (http://www.sqlite.org/)  

− Official website for MS SQL Server 
(http://www.microsoft.com/korea/sqlserver/2008/default.aspx) 

6.2.2 Using PuTTY 

To access a server, you need to use PuTTY, which is a remote access program. PuTTY is only 
available for the servers supporting Telnet or Secure Shell (SSH) protocols. 

The procedure used to install and use the PuTTY is as follows: 

1. Download the setup file from the official PuTTY website 
(http://www.chiark.greenend.org.uk/~sgtatham/putty/).  

2. After executing the downloaded PuTTY, enter the server IP address to Host Name on the 
PuTTY Configuration window and click Open at the bottom of the window. 

3. If the login window appears, enter your ID and password in turn.  

You cannot check your input information because there is no change when entering password. 
When, however, pressing Enter after entering the password correctly, you can see whether 
the authentication request is passed or failed. 

http://www.cubrid.com/zbxe/home
http://www.firebirdsql.org/
http://www.mysql.com/
http://www.postgresql.org/
http://www.sqlite.org/
http://www.microsoft.com/korea/sqlserver/2008/default.aspx
http://www.chiark.greenend.org.uk/~sgtatham/putty/
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Figure 6-2 PuTTY Login Window 

6.2.3 Uploading XE Core Setup File 

To upload the setup file stored in My Computer to the web server, you need a File Transfer 
Protocol (FTP) program. In this document, FileZilla, which is a free and open program, is used. 
You can get FileZilla from the FileZilla official website (http://filezilla-
project.org/download.php?type=client).  

With FileZilla, access the server to install XE, and upload the setup file. 

− Host: A server domain address or IP address 

− Username: An account with server access permission. Enter the account used when 
getting access to the server by using above described PuTTY. 

− Password: An account password 

− Port: An FTP port number of the access server. In general, 21 is used as the port 
number. If you cannot access the server, check the FTP port number of the access 
server again. The server administrator may have changed the FTP port number. 

http://filezilla-project.org/download.php?type=client
http://filezilla-project.org/download.php?type=client
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Figure 6-3 FileZilla Screen Shown When Server Access Succeed 
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6.3 Uploading XE Core Setup File by Formats 

You can upload XE core file to a web server in two ways:  

• Uploading to the server after downloading and extracting a zip file 
• Extracting a tar.gz file after downloading the file and uploading to the server  

Select more convenient method between the two methods. 

Uploading a zip File After Extracting 

1. Download the XE core setup file whose extension is .zip to My Computer and extract it. 
2. Upload the unzipped file included in the xe directory to the server by using FileZilla. 

Note 
Upload the XE core file to the root directory of the server. If, for example, you upload the xe 
directory to the root directory of a 'manual.xpressengine.com' server, you must access 
'manual.xpressengine.com/xe.' 

Extracting a tar.gz File After Uploading 

Under Windows environment, the compressed file is extracted by using a file compression 
program already installed after uploading the file.  

Under Linux environment, the compressed file is extracted after uploading the file as follows: 

1. Download the XE core setup file whose extension is tar.gz to My Computer and upload the 
file to your server. 

2. After getting access to the server by using PuTTY, move to the root directory.  
3. Enter the ls command to check if xe.x.x.x.tar.gz file is uploaded. 
4. Extract the compression of a tar.gz file by using the tar command (option xzf).  
5. Move the files under the xe directory to the webroot directory by using the mv command. 

Now, you can access the Web page through the domain path.  
mv xe/* . 
mv xe/.htaccess . 

At this time, make sure that a dot (.) at the end of the command is not missing. 
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6. Since you have already extracted the xe.x.x.x.tar.gz file and have moved all files under the 
xe directory, delete the xe.x.x.x.tar.gz file and the xe directory by using the rm command. 

Note 
For a detailed description about Linux commands, see "Linux Commands." 
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6.4 Linux Commands 

6.4.1 Command to Compress or Extract Files - tar 

Command Format: tar <Operation> [Options] (Directory path or compressed file path) 

<Operation> 

• [-]A: Concatenate a second tar file to the end of the first. 
• [-]c: Create a new tar file. 
• [-]d: Compare the files stored in tar file with other files. Report any differences.  
• [-]r: Append other files to the end of an existing archive.  
• [-]t: Print the names of files stored on the archive. 
• [-]u: Add files if not in the archive or it modified.  
• [-]x: Extract the compressed file 
• --delete: Delete from the archive. 

<Common Options> 

• -C: Specify the directory before beginning tar operation. 
• -f: It is used to specify a file name. 
• -j: Compress files with bzip2 before archiving them, or uncompress them with bunzip2 

before extracting them. 
• -p: Keep the attributes such as permission, directory and owner of extracted files the same 

as the originals. 
• -v: Print filenames as they are added or extracted. 
• -z: compress into or extract gzip files in a batch. 

6.4.2 Command to Remove Files and Directories - rm 

Command Format: rm [Option] (File or directory path) 

[Option] 

• [-]f: Remove write-protected files without prompting. 
• [-]r: Remove the entire directory and all its contents, including subdirectories. 
• [-]v: Print the name of each file before removing it.  

6.4.3 Command to Move Files and Directories - mv 

Command Format: mv [option] (File or directory path) (File name of directory path) 

[Option] 

• [-]b: Back up files before removing. 
• [-]f: Force the move, even if target file exists.  
• [-]u: Do not remove a file or link if its modification date is the same as or newer than that 

of its replacement. 
• [-]v: Print the name of each file before moving it. 

6.4.4 Command to Create Directories - mkdir 

Command Format: mkdir [Option] (Directory name) 
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[Option] 

[-]p: Create intervening parent directories if they don't exist.  

6.4.5 Command to Change File and Directory Permissions - chmod 

Command Format: chmod [Option] <mode> (File or directory path) 

[Option] 

• [-]c: Print information about files that are changed. 
• [-]f: Do not notify user of files that chmod cannot change. 
• [-]v: Print information about each file, whether changed or not. 
• [-]R: Traverse subdirectories recursively, applying changes. 

<mode> 

Files and directories have three types of permissions: read (r), write (w) and execute (x). 
Each permission has its own value and can create a mode with the value that the unique 
values are added. 

User Group Others 

r w x r w x r w x 

400 200 100 40 20 10 4 2 1 

700 70 7 

For example, if you want to assign all permissions, you can use 777, which is the sum of all 
values within the table, as mode. If you want to assign all permissions to a user, and read and 
execute permissions to other users, set mode to 755. 

6.4.6 Command to Create Accounts - useradd 

Command Format: useradd [Option] (account name) 

[Option] 

• [-]u: A user ID 
• [-]g: A group ID or group name 
• [-]s: SHELL information 
• [-]d: A home directory 
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6.5 Error Handling 

This section describes the errors that can be generated when you install and set XE, and how 
to handle them. 

6.5.1 Insufficient Version of MySQL 

• Error: A message that says "XE cannot be installed under the version of MySQL 4.1. 
Current MySQL version is x.x.x-log" appears. 

• Cause: It occurs when the installed version of My SQL version is lower than the minimum 
supported version. 

• Solution: Update MySQL to version 4.1 or higher.  

6.5.2 Incorrect DB Account Information 

• Error: A message that says "Access denied for user ‘xxx’@’xxxx’ (using password: YES) 
xxx" appears. 

• Cause: It occurs when DB account does not exist, password is wrong or you do not have 
the access permission to the database to connect. 

• Solution: Check to ensure that you correctly entered account setting, access permission 
information and database information. 

6.5.3 Incomplete Permission Settings When Installing XE  

 

Figure 6-4 Screen Shown When Permission Settings Incomplete 

• Error: A message that says "[Required] XE installation path or ./files directory's permission 
must be 707." appears. 

• Cause: It occurs when the files directory does not exist in the XE installation path. 
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• Solution (Windows): Check whether the files directory exists in the XE installation path.  

In Windows XP, you can install XE without setting the permission for files or folders. In 
Windows 7 (IIS7), however, you must grant permissions to IIS_ISURS (group) and IUSRS 
(user) as follows:   

a. Right-click the XE installation folder (C:\Inetpub\wwwroot\xe) and then select 
Properties from the Context menu. 

b. Select the Security tab in the Properties window of the folder. 
c. Click Edit in the center of the window. 
d. Check that there are IIS_IUSRS group and IUSR user within the Group or user names 

list on Permissions window. If not, click Add. 
e. In the Select Users or Groups window, enter IUSR under Enter the object names 

to select, click Check Names and then click OK. 
f. Click Add in the Permissions window again. 
g. At this time, enter IIS_USRS in the Select Users or Groups window, click Check 

Names and then OK. 
h. If all users and groups are added, select IUSR, click the Allow checkbox for Full 

control as shown below and then click Apply. 

 

i. In addition, set for IIS_IUSRS in the same manner as above. 
• Solution (Linux): Check whether the files directory exists in the XE installation path. 

In the Linux environment, if the files directory does not exist, create the files directory by 
using the mkdir command and set permissions by using the chmod command. 
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6.5.4 FTP Home Directory Inaccessible during Easy Install 

• Error: A message that says "msg_make_directory_failed" appears. 
• Cause: It occurs when the value of "FTP path setting of the installed XE" in website 

environment is wrong. 
• Solution: After checking the absolute path of the installed XE path, set the value again. 

You must add '/' at the end of the XE absolute path. 
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